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Abstract: The topographic plane of the Earth has irregular shape, and for the 
purpose of mathematical defining, it is to be approximated by rotational ellipsoid. 
As local geodetic datum, rotational ellipsoids of various sizes are used in the 
world. More widely usage of the GPS while performing surveying tasks has 
resulted in the need to define global geodetic datum in order to obtain the best 
approximation the entire Earth. For this purpose, geocentric rotational ellipsoid 
WGS84 was defined and the results of the GPS measurements are shown in 
relation to it. By applying the appropriate equations, the ellipsoidal coordinates 
are being transformed from WGS84 into the coordinates on the local rotational 
ellipsoid, i.e. on the view plane. The paper shows User Defined Function created 
for Excel, by which the coordinates in the territory of Belgrade are being 
transformed from WGS84 of rotational ellipsoid into the Gauss-Krüger projection 
plane. 
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Apstrakt: Topografska površ Zemlje je nepravilnog oblika, a u cilju 
matematičkog definisanja, aproksimira se obrtnim elipsoidom. Kao lokalni 
geodetski datumi u svetu se koriste obrtni elipsoidi različitih dimenzija. Sve 
masovnija upotreba GPS-a pri obavljanju geodetskih radova uslovila je potrebu 
definisanja globalnog geodetskog datuma kojim će se najbolje aproksimirati cela 
Zemlja. U tom cilju, definisan je geocentrični obrtni elipsoid WGS84 i rezultati 
GPS merenja se prikazuju u odnosu na njega. Primenom odgovarajućih 
jednačina, elipsoidne koordinate iz WGS84 transformišu se u koordinate na 
lokalnom obrtnom elipsoidu, odnosno projekcionoj ravni. U radu je prikazana 
User Defined Function kreirana za Excel, kojom se na teritoriji Beograda 
transformišu koordinate sa WGS84 obrtnog elipsoida u ravan Gaus-Krigerove 
projekcije. 
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1. INTRODUCTION 
 
 The satellite geodesy today, has a significant role for the navigation and point 
positioning on Earth. Two satellite navigation systems are known and are used in 
practice, American GPS and Russian GLONASS. After many years of delay and 
testing, launching and establishment of the European satellite system GALILEO has 
begun, which should be completely operative in 2014 (Mendizabal et al. 2009). The 
position of the receiver on Earth is being determined by the method of pseudo-ranges 
between known satellite positions and the receivers (French, 1996). Regardless if the 
surveying is performed by using absolute or differential static, kinematic or kinematic 
method in real time (RTK), positions of points, i.e. of the receiver, are determined in 
relation to the rotational ellipsoid WGS84 (World Geodetic System 1984) (Božić, 
2006). The so called GPS measurements in Geodesy are more and more present both 
for the resolving of complex and complicated tasks and when performing basic 
surveying works, such as surveying and detailed site and objects surveying (Ganić et 
al. 2012). 
 Exploratory works in mining and geology are very significant and precede the 
extraction of mineral raw materials as well as the construction of building, industrial, 
traffic and all other infrastructural structures. The data on the composition, age and 
structural-tectonic relations of undersurface parts of the Earth crust are obtained from 
exploratory wells, and as such they may be used at wider area by using different 
geological and geophysical tests. In order to apply appropriately the results obtained in 
this way in other engineering disciplines exploratory wells must be georeferenced, i.e. 
thy must be shown in the national coordinate system. 
 

 

Figure 1 - Orthophoto with exploratory wells with ellipsoidal coordinates 
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 Along the Belgrade riverside by the rivers Sava and Danube a large number of 
special purpose exploratory wells were done (Figure 1), which also were used for 
explorations of certain stratigraphic members of the neogene and quarternary as well as 
for the purpose of understanding of kinematic movements (Ganić et al. 2011; Knežević 
et al. 2011). Some of them were made for the purposes of geotechnical testing of 
bearing capacity and stability of the terrain for the purpose of construction of the new 
bridge over Ada Ciganlija. The positioning of those wells was made by using methods 
of satellite geodesy. However, in individual cases, there were only ellipsoid 
coordinates of wells at the disposal. This has initiated creation of the WGS2GK 
function, which is used in Excel and by using which the transformation of ellipsoid 
coordinates on WGS84 ellipsoid is made into Cartesian coordinates within the plane of 
Gauss-Krüger projection. 
 
 

2. GEOID AND ROTATIONAL ELLIPSOIDS 
 
 The topographic plane of the Earth has irregular shape. Difference in elevation 
between the highest point on Earth and the deepest point in the Pacific Ocean is almost 
20 km. 
 Seas and oceans make more than 70% of the Earth's surface. By connecting all 
water together, a continuous closed curved line would be obtained, which represents 
datum level, and a body formed in such a way is called the geoid. Due to the different 
density and irregular mass arrangement in the Earth's interior, the geoid is slightly 
waved, with altitude alterations up to 200 m. This waviness is causing the mathematical 
indefinableness of the geoid. 
 For mathematical description of geoid, two geometric bodies are used, the 
sphere and ellipsoid. The sphere is less precise approximation of geoid, which is used 
with small scales. The ellipsoid is the most accurate approximation of the geoid. 
Dimensions of rotational ellipsoid are so determined that it approximates geoid best, 
i.e. that the sum of volumes of exaltations and depressions (undulation) is minimal. 
Countries adopt the appropriate dimensions of the rotational ellipsoid, the so called 
local geodetic data, in order to obtain as good approximation on its territory as 
possible. 
 As other countries of former Yugoslavia, Serbia has, in 1924, adopted Bessel's 
ellipsoid as geodetic datum – rotational ellipsoid, whose dimensions were determined 
in 1841: 
- semi-major axis of the ellipsoid 6377397.155mBesa  ; 

- semi-minor axis of the ellipsoid 6356078.963mBesb  . 

 Moreover, for mapping from rotational ellipsoid onto the plane the Gauss-
Krüger three-stage conform cylindrical projection was adopted. The position of points 
in the Gauss-Krüger projection is defined by Cartesian coordinates y and x as well as 
by the altitude (orthometric height) h. 
 The satellite geodesy has caused the conversion from local non-geocentric data 
to global datum and introduction of the unique rotational ellipsoid. The reference 
ellipsoid for GPS positioning is geocentric WGS84 ellipsoid. The position of points on 
the ellipsoid is defined by: ellipsoidal – curvilinear coordinates (latitude , longitude  
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and normal – ellipsoidal height H) or by Cartesian – rectangular coordinates, whereby 
the X-axis lies within the plane of equator and it is normal to intersection point between 
the equator and Greenwich meridian, and the Y-axis lies within the equator plane and it 
is normal to X-axis, and the Z-axis is oriented towards the axis of rotation of the Earth. 
The dimensions of the ellipsoid WGS84 are: 

- semi-major axis of the ellipsoid 6378137.0mWGSa  ; 

- flatness 1: 298.257223563f  . 
 
 

3. COORDINATE TRANSFORMATION FROM WGS84 
    INTO GAUSS-KRÜGER PROJECTION 
 
 Transformation of results of GPS measurements into the plane of Gauss-
Krüger projection is to be performed at several stages (www.fgg.uni-lj.si): 
 I stage - usual method to show results of GPS measurements is in form of 
ellipsoidal coordinates, so that at this stage the so called geographical transformation is 
done, by which the ellipsoidal coordinates are translated into Cartesian coordinates 
within the same datum (ellipsoid): 
  , , , ,WGS WGS WGS WGS WGS WGSH X Y Z    

The equations are (Bulatović, 2013): 
    cos cosWGS WGS WGS WGSX N H       

    cos sinWGS WGS WGS WGSY N H       

    21 sinWGS WGS WGS WGSZ N e H                    (1) 

whereby: 
N - is the radius of curve upon the first vertical circle and it is to be calculated by using 
the following equation: 
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2
WGSe  - which is to be calculated by using the equation: 
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WGSb  - semi-minor axis of rotational ellipsoid: 

  WGS
WGS WGS

a
b a

f
                   (4) 

 II stage - datum transformation, by which the Cartesian coordinates are 
translated from WGS datum into Bessel's ellipsoid: 
  , , , ,WGS WGS WGS Bes Bes BesX Y Z X Y Z  

One of the most commonly use method of datum transformation is Helmert's seven 
parameter transformation (Liker et al. 2010), which consists of three translations of the 
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origin of coordinates over axes (tx, ty, tz), three angles of rotation of coordinate axes (x, 
y, z) and the alteration of scale s (http://ccd.uns.ac.rs): 

   
1

1 1

1

Bes z y WGS x

Bes z x WGS y

Bes y x WGS z

X X t

Y s Y t

Z Z t
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 

       
                  
             

              (5) 

 III stage - geographical transformation from Cartesian into ellipsoid 
coordinates within Bessel's ellipsoid: 
  , , , ,Bes Bes Bes Bes BesX Y Z h   

The latitude is most often calculated by using the iteration method (Božić, 2001): 
The first iteration: 
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other iterations: 

  
2

1

sin
arctan Bes Bes i i

i

Z e N

D


 

  
                (7) 

whereby the radius of the curve upon the first vertical circle is calculated after every 
iteration; and on the basis of this vertical the latitude is calculated in the next iteration. 
Simpler equation may also be used here: 
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                 (8) 

 Iterations end when latitudes from two consecutive iterations are equal. In this 
way the final value of latitude on Bessel's ellipsoid Bes is obtained. Longitude and 
altitude are calculated by using the following equations: 

  arctan Bes
Bes

Bes

Y

X
                   (9) 

  
cos i

Bes

D
h N


                 (10) 

whereby D stands for the radius of parallel: 

  2 2
Bes BesD X Y                 (11) 

 At this transformation, values of semi-major axis aBesand semi-minor axis 
bBesare used, which define the size of the Bessel's rotational ellipsoid. With those 
values, the first numerical eccentricity is calculated by using the equation (3). 

 IV stage - transformation of ellipsoidal coordinates into Cartesian coordinates 
within the plane of Gauss-Krüger projection, whereby the altitude remains the same: 
   , , , ,Bes Bes GK GKh x y h    

First, the so called undiminished (unmodulated) coordinates are to be calculated by 
using the following equations (Božić, 2001): 
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whereby the following applies: 
X  - the length of the meridian arc: 

  sin 2 sin 4 sin 6 sin8 ...Bes Bes Bes Bes BesX                         (14) 

whereby the parameters are as follows: 

  2 41 1
1 ...

2 4 64
Bes Besa b

n n
       

 
 

  3 53 9 3
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n n n       

  2 415 15
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16 32
n n     
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t  - auxiliary value: 
  tan Best                  (15) 
  - auxiliary value: 

  cos Bese                   (16) 

whereby 2e represents the second numerical eccentricity, which is calculated by using 
the equation: 
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l - the difference between the latitudes of the point and the central meridian of the 
mapping zone: 
  Bes ol                    (18) 

 The final equations of the point in Gauss-Krüger coordinate system, the so 
called diminished (modulated) coordinates, are calculated by using the following 
equations: 

  
0,9999

0,9999
GK

GK

x x

y y K

 

  
               (19) 

whereby K represents the constant, which amounts 7 500 000 for the seventh coordinate 
system, i.e. 6 500 000 for the sixth coordinate system. 
 
 
4. USER DEFINED FUNCTION WGS2GK 
 
 Excel is a part of software package Microsoft Office and it is one of the most 
frequently applied and most popular software for tabular calculations. It has a large 
number of ready-made functions divided into nine categories, but it also enables for the 
users to create their own User Defined Functions (UDF), which are used in the same 
way as all other functions within Excel (Walkenbach, 2003). 
 UDFs are created by accessing the Visual Basic Application (Alt+F11), next 
new module is opened (Insert>Module) and the appropriate program is entered. After 
exiting Visual Basic Application, created function can be used in Paste Function 
dialog, in category User Defined. Should the function be available for several 
workbooks, it is necessary to save Excel's file with created function as add-in file 
(.xla). By opening the new workbook, the add-in file is loaded (Tools>Add-Ins) and 
the created function is available for use (Vulić and Durgutović, 2007). 
 According to the stated options of Excel, and in compliance with the equations 
stated, the WGS2GK function was created, which transforms ellipsoidal coordinates 
from WGS84 of the ellipsoid into Cartesian coordinates within Gauss-Krüger system. 
 The dimensions of both rotational ellipsoids, as well as seven parameters of 
datum transformations, in fact the parameters for Belgrade, were entered into the 
program as constants. The translation parameters are given in meters, rotation 
parameters in seconds and the scale change in ppm. The listing of the WGS2GK 
function is shown below. 
 
Function WGS2GK(fist As Integer, fimn As Integer, fisek As Double, 
lamst As Integer, lammn As Integer, lamsek As Double, hwgs As 
Double) As Variant 
Dim pi As Double 
Dim awgs As Double, fred As Double 
Dim fiwgsrad As Double, lamwgsrad As Double 
Dim bwgs As Double, nwgs As Double 
Dim xwgs As Double, ywgs As Double, zwgs As Double 
Dim tx As Double, ty As Double, tz As Double 
Dim epx As Double, epy As Double, epz As Double 
Dim s As Double 
Dim epxrad As Double, epyrad As Double, epzrad As Double 
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Dim abes As Double, bbes As Double 
Dim e As Double, d As Double 
Dim i As Integer 
Dim fi(20) As Double 
Dim n(20) As Double 
Dim fibesrad As Double, lambesrad As Double, hbes As Double 
Dim nn As Double, alfa As Double, beta As Double, gama As Double, 
delta As Double, epsi As Double 
Dim bfi As Double, eprim As Double, eta As Double, veln As Double 
Dim Zone As Integer 
Dim t As Double, l As Double 
Dim xmalo As Double, ymalo As Double 
Dim xgk As Double, ygk As Double, hgk As Double 
Dim toOut(2) As Double 

pi = 4 * Atn(1) 
awgs = 6378137 
fred = 298.257223563 
tx = -534.17298 
ty = -205.23457 
tz = -465.63379 
epx = 5.28083 
epy = 1.6713 
epz = -14.20538 
s = -0.0000025456 
abes = 6377397.155 
bbes = 6356078.963 

fiwgsrad = (fist + fimn / 60 + fisek / 3600) * pi / 180 
lamwgsrad = (lamst + lammn / 60 + lamsek / 3600) * pi / 180 

bwgs = awgs - awgs / fred 
nwgs = awgs ^ 2 / Sqr(awgs ^ 2 * (Cos(fiwgsrad)) ^ 2 + bwgs ^ 2 * 
(Sin(fiwgsrad)) ^ 2) 

xwgs = (nwgs + hwgs) * Cos(fiwgsrad) * Cos(lamwgsrad) 
ywgs = (nwgs + hwgs) * Cos(fiwgsrad) * Sin(lamwgsrad) 
zwgs = ((bwgs ^ 2 / awgs ^ 2) * nwgs + hwgs) * Sin(fiwgsrad) 

epxrad = (epx / 3600) * pi / 180 
epyrad = (epy / 3600) * pi / 180 
epzrad = (epz / 3600) * pi / 180 

xbes = (xwgs + ywgs * epzrad + zwgs * -epyrad) * (1 + s) + tx 
ybes = (xwgs * -epzrad + ywgs + zwgs * epxrad) * (1 + s) + ty 
zbes = (xwgs * epyrad + ywgs * -epxrad + zwgs) * (1 + s) + tz 

e = 1 - (bbes ^ 2 / abes ^ 2) 
d = Sqr(xbes ^ 2 + ybes ^ 2) 

i = 0 
fi(i) = Atn(zbes / (d * (1 - e))) 
GoTo 80 
50  fi(i) = Atn((zbes + e * n(i - 1) * Sin(fi(i - 1))) / d) 
80  n(i) = abes / (Sqr(1 - e * (Sin(fi(i))) ^ 2)) 
If i = 0 Then GoTo 90 
If fi(i) = fi(i - 1) Then GoTo 100 
90  i = i + 1 
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GoTo 50 
100 fibesrad = fi(i) 
nbes = n(i) 
lambesrad = Atn(ybes / xbes) 
hbes = d / Cos(fibesrad) - nbes 

nn = (abes - bbes) / (abes + bbes) 
alfa = ((abes + bbes) / 2) * (1 + nn ^ 2 / 4 + nn ^ 4 / 64) 
beta = -(3 * nn / 2) + (9 * nn ^ 3 / 16) - (3 * nn ^ 5 / 32) 
gama = (15 * nn ^ 2 / 16) - (15 * nn ^ 4 / 32) 
delta = -(35 * nn ^ 3 / 48) + (105 * nn ^ 5 / 256) 
epsi = 315 * nn ^ 4 / 512 

bfi = alfa * (fibesrad + beta * Sin(2 * fibesrad) + gama * Sin(4 * 
fibesrad) + delta * Sin(6 * fibesrad) + eta * Sin(8 * fibesrad)) 
eprim = (abes ^ 2 - bbes ^ 2) / bbes ^ 2 
eta = eprim * (Cos(fibesrad)) ^ 2 
veln = abes ^ 2 / (bbes * Sqr(1 + eta)) 

If lambesrad >= (13.5 * pi / 180) And lambesrad < (16.5 * pi / 180) 
Then Zone = 5 
If lambesrad >= (16.5 * pi / 180) And lambesrad < (19.5 * pi / 180) 
Then Zone = 6 
If lambesrad >= (19.5 * pi / 180) And lambesrad <= (23 * pi / 180) 
Then Zone = 7 

t = Tan(fibesrad) 
l = lambesrad - (Zone * 3 * pi / 180) 

xmalo = bfi + t / 2 * veln * (Cos(fibesrad)) ^ 2 * l ^ 2 + t / 24 * 
veln * (Cos(fibesrad)) ^ 4 * (5 - t ^ 2 + 9 * eta + eta ^ 2) * l ^ 4 
+ t / 270 * veln * (Cos(fibesrad)) ^ 6 * (61 - 58 * t ^ 2 + t ^ 4 + 
270 * eta - 330 * t ^ 2 * eta) * l ^ 6 + t / 40320 * veln * 
(Cos(fibesrad)) ^ 8 * (1385 - 3111 * t ^ 2 + 543 * t ^ 4 - t ^ 6) * 
l ^ 8 
ymalo = veln * Cos(fibesrad) * l + veln / 6 * (Cos(fibesrad)) ^ 3 * 
(1 - t ^ 2 + eta) * l ^ 3 + veln / 120 * (Cos(fibesrad)) ^ 5 * (5 - 
18 * t ^ 2 + t ^ 4 + 14 * eta - 58 * t ^ 2 * eta) * l ^ 5 + veln / 
5040 * (Cos(fibesrad)) ^ 7 * (61 - 479 * t ^ 2 + 179 * t ^ 4 - t ^ 
6) * l ^ 7 

xgk = xmalo * 0.9999 
ygk = ymalo * 0.9999 + (Zone * 1000000 + 500000) 
hgk = hbes 

toOut(0) = xgk 
toOut(1) = ygk 
toOut(2) = hgk 
WGS2GK = toOut 

End Function 
 
 

 As seen from the listing, it is necessary to enter degrees, minutes and seconds 
of latitude and longitude of the point from WGS84 as well as ellipsoidal altitude of the 
point into seven cells of the worksheet. After this, three cells are to be selected, where 
coordinates of the point in Gauss-Krüger coordinate system should be shown. The 
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(Insert>Function) function is to be inserted and the created function WGS2GK (Figure 
2) is to be selected from the User Defined category. 
 

 

Figure 2 - Inserting of WGS2GK function 
 
 

 Addresses of seven cells, where all necessary input data are, are to be entered 
into the window Function Arguments (Figure 3). 
 

 

Figure 3 - Entering of arguments of the WGS2GK function 
 
 

 After entering arguments by pressing Ctrl+Shift+Enter key, results of 
transformed coordinates are shown in selected cells. For other calculations, one can 
insert the function in worksheet again or simply copy cells where calculations were 
done. Figure 4 shows transformed coordinates of exploratory holes (Figure 1). 
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Figure 4 - Results of the transformation of coordinates of exploratory wells 
 
 

 Based on this function, functions for partial calculations were derived as well: 
WGSEli2Cart - function for geographic transformation of ellipsoidal coordinates into 
Cartesian within the WGS84 ellipsoid; 
WGS2Bess - function for datum transformation of Cartesian coordinates from WGS84 
into coordinates on Bessel's ellipsoid; 
BessCart2Eli - function for geographic transformation of Cartesian coordinates into 
ellipsoidal ones within Bessel's ellipsoid and 
BessEli2GK - function for transformation of ellipsoidal coordinates on Bessel's 
ellipsoid into rectangular coordinates within the plane of Gauss-Krüger projection. 
 
 

5. CONCLUSION 
 
 By using options of Excel software to create new functions, which are to be 
used in the same way as the ones already integrated within it, the WGS2GK function 
was created. The transformation of ellipsoidal coordinates determined by GPS devices 
into rectangular coordinates within the plane of Gaus-Krüger projection is performed 
by this function. 
 The dimensions of rotational ellipsoid WGS84, as well as the Bessel's one, are 
constants and they are entered into the function. Also, because of the reason for 
creation of the said function they are entered as constants and parameters applied for 
Belgrade. Transformation parameters are different with each cadastral municipality, 
and by entering into Visual Basic Application (Alt+F11) those parameters may be 
altered (while maintaining units and forms shown in listing). In this way, the WGS2GK 
function can be used in the entire Serbia as well as in other countries of former 
Yugoslavia. 
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